SQL Specialist 2.0.5
for Microsoft & Sybase SQL Servers

System Requirements. windows 9x, NT, 2000, XP, Vista.

What's New

Version 2.0.5 (August 18, 2010)
1) Added ability to reposition configured servers by nudging them up and down.
2) Fixed problem when updating rows in the grid that contain aNULL key value.

Version 2.0.4 (August 15, 2010)

3) Added ability to configure server name aliases for logon dialog.
4) Useof TOP will no longer invalidate ability to Allow Edit.

5) Catch additional errors.

Version 2.0.3 (March 25, 2010)
1) Fixed problem with trigger names showing up under table view.
2) Added missing keywords.

Version 2.0.2 (August 26, 2009)
1) Fixed problem when returning an empty data row.

Version 2.0.1 (July 15, 2009)
1) Fixed problem when opening filesfrom HTTP link

Version 2.0.0 (January 26, 2009)

1) Added ability to build insert SQL from any result Grid (previously limited to table rows).
2) Added ability to generate update SQL statements from Grid cells.

3) Added "[Disabled] Triggers' folder under each Database in the object tree.

4) Added menu “View Rows (Grid)” to the existing “View Rows (Text)”.

5) Added ability to drag objects from object tree to copy object’s name or copy list of objects.
6) Added ability to paste on an editable grid cell without first double clicking the cell.

7) Added ability to clear server list from preferences.

8) Added Utilities->Convert Rows To List.

9) Added Utilities->Remove Trailing Space From Rows.

10) Added Utilities->Comment

11) Added Utilities->Uncomment

12) Added Utilities->Make Lowercase

13) Added Utilities->Make Uppercase

14) Added Utilities->Increase Indent

15) Added Utilities->Decrease Indent



16) Added Utilities->Convert Tabs To Single Space

17) Added Utilities->Convert Tabs To Equivalent Space

18) Added preference to set maximum initial column width for grids.
19) Added preference to set initial field for logon window.

20) Search dialog will now show recently added databases.

21) Search dialog has been widened to handle larger DB names.

22) Search dialog will default to your ‘current’ DB if not using setting to default to previous search.
23) Utilities->DBDateTime Converter now handles milliseconds correctly.

24) Utilities->DBDateTime Converter now performs conversion as you type.

25) Changed behavior of Delete key to match Backspace key when entering edit mode on a grid cell.
26) SQL Preview dialog will now wrap SQL to fit window.

27) Current directory will now be saved when opening multiple files from that directory.

28) Changed behavior when clicking a grid's row header with relation to an existing block selection.
29) All generated SQL requiring quotes will now use single quotes.

30) SQL Preview and SQL Message dialog will now close when clicking the (X) or hitting Escape.
31) Changed default server typeto MS SQL.

32) Copy Name menu is now disabled on the Database folder itself.

33) Fixed building of insert SQL from DB dataif extra columns were sel ected.

34) Removed erroneous quotes around binary fieldsin generated insert SQL (DB version).
35) Fixed checkmarks in menus when Win XP's " Show shadows under menus' option is on.
36) Processes tab now sets reasonabl e column widths.

37) Spaces entered into numeric cells will now be detected and treated as errors.

38) Modified row trimming rules to match Query Analyzer.

39) Modified generated SQL to output UPPERCA SE keywords.

40) Added ahility to Open/Save Unicode files (although non-ASCII characters are lost).

Version 1.6.3 (November 18, 2004)

1) Added ability to display lines up to 3 million characters.

2) Added ability to display text columns up to 1 million characters (see configuration)
*Grid cells will aways contain entire value up to 1 million characters.

3) Added ability to display columns of type uniqueidentifier (SQL_GUID)

4) Added missing keywords for syntax coloring.

Version 1.6.2 (February 28, 2004)
1) Editor: Double clicking aword that extends past the right of the window would select too much.

2) Editor: Very long lines would not always draw correctly under XP.
3) Editor: Huge performance improvement when syntax coloring long lines with many spaces.
4) Editor: Lines with more than 600 tokens will no longer be syntax colored.

5) Editor: Added missing keywords for syntax coloring.

6) Editor: Enlarged RS/Row and LN/Col sections in status bar.

7) Editor: Clicking inside selected text fails to update internally tracked cursor position.

8) New concept: Added #pragmafor setting SQL Specialist options within query. * See Below
9) Utilities: Added "Utilities->Collapse Spaces".

10)  Utilities: Added "Utilities->Space Separated to Comma Separated”.

11)  Utilities: Added "Utilities->Convert Rows To Quoted List".

12)  Utilities: "Utilities->Remove Carriage Return” generates error if no text to process.



13)  Utilities: Now available for results window.
14)  Browser: "Copy Name" can now be used for DB names too.

* More Info: #pragma
o Example: #pragmaremoveCR [true/false/default] /[1/0] /[on/off/default] )
o All #pragmas before a GO statement are processed before query execution.
e #pragma changes persist per window.

Version 1.6.1 (February 1, 2004)

1) MSSQL: Queriesthat start with an update, but don't update any rows would fail to return
subsequent result sets within the batch.

2) MSSQL: Grid updates would occasionally fail due to a combination of bug #1 and triggers.

3) Distinct command would be lost when executing to grid and unique key contains multiple cols.

4) Copying all rowsin Single Row Edit mode would copy the first line twice.

5) Syntax Coloring: Lines starting with # should only be colored if starting with #define.

Version 1.6.0 (September 27, 2003)
1) MSSQL: T-SQL print statements are now displayed.
2) MSSQL: Function group is now positioned a phabetically.
3) MSSQL: Reported row count will now work for multi-statement batches with triggers invol ved.
4) MSSQL: Will now retrieve result sets that may occur after certain SQL errors.
5) MSSQL: When browsing, only tables are differentiated between system and user objects.
6) Configuration: Added ability to configure the default DB per server.
7) Configuration: Can now configure number of server names to remember (defaults to 30).
8) Configuration: Removed configuration for maximum number connections allowed.
9) Configuration: Removed Apply button from config dialog.
10)  Configuration: Ability to add your own ‘open file' extensions.
11)  Configuration: Changed the default for Query->Remove CRs to true (you can always set it back).
12)  Col headers are now copied when grid is copied to clipboard (if more than one cell is selected).
13)  Added ~100 more keywords for syntax coloring.
14)  Added ability to open multiple files from file->open.
15)  Added favorites functionality.
16)  Added ability to inject file into current query window by holding shift while selecting favorite.
17)  Added 'Copy Name' as option when browsing objects.
18) Nolonger add a Carriage Return to end of copied value if only asingle grid cell is being copied.
19)  When saving anew file, .SQL extension will not be added if custom file extension is used.
20)  Doubleclicking .SQL file no longer opens 2 windows.
21)  Fixed occasional erroneous message prompting to reload a changed file when it didn't change
and was loaded using the MRU list.
22)  Improved auto scroll to ensure find results, typing, etc remains visible.
23)  Reverse Find now searches within the line backwards and not just walk each row backwards.
24)  Fixed scroll wheel error on Single Row Edit when only one columnin list.
25)  Query->"Show Insert SQL" now reads"Copy Insert SQL To Clipboard".
26)  Improved spacing between multiple result sets, messages, etc.
27)  Menusnow have Visua Studio .NET 2003 |ook.
28)  Registration fee reduced to $10.
29)  Computers owned by asite-licensed organization no longer require aregistration key.
(All other uses will require a purchased registration key.)



Version 1.5.4 (October 29, 2002)

1. Added more tokens for syntax coloring.

2. Microsoft SQL: Can now display sgl_variant types.

3. Fixed problem with getting prompted twice when closing the app and choosing not to save
changed documents.

4, Sybase SQL: "select convert( float, null )" to grid mode would show the value as zero and null at
the same time.

5. Search dialog values defaulted to incorrect values in some scenarios.

6 Print Preview buttons now work.

Version 1.5.3 (August 5, 2002)
1 Microsoft SQL: No longer left trim returned values.

Version 1.5.2 (August 1, 2002)

1 Fixed error when displaying errorsin grid mode.

2. Microsoft SQL: Added browsing/search support for functions.

3. Microsoft SQL: Help->DLL Versions shows ODBC version info.
4 Searching for text contains now also searches object names.

Version 1.5.1 (July 25, 2002)
1. Fixed crash related to syntax coloring.

Version 1.5.0 (July 21, 2002)

1. Microsoft SQL: No longer requires SQLDMO.

2. Microsoft SQL: Add Configuration to use SQLDMO if installed.

3. Microsoft SQL: Fixed crash when displaying very large binaries.

4 Microsoft SQL: Fixed problem where Allow Updates was disabled if using double quotes as
string delimiter and quoted_identifier was off.

5. Regardless of the configured display length, up to 65536 characters
for each column can be copied from agrid cell.

6. Can configure text display for a column to be up to 65536 characters.
[It is recommended you keep this value lower and use #5 as needed]

7. Text window now supports an unlimited display width.

8. When removing carriage returns from result rows, next column will no longer be shifted left.

9 Depending on context, F5 will now Refresh Object Workspace, Refresh Server Status, or
Execute query.

10. Show Insert/Delete SQL in grid mode now sends text directly to clipboard.

11. Insert/Delete SQL copied to clipboard now contains column list.

12. New Instaler.

Version 1.4.0 (May 6, 2002)
1. Microsoft SQL: Added support for Microsoft SQL Server datatypes. SmallDateTime, NText,
BigInt, SmallMoney.



Microsoft SQL: Null bit field now shows as NULL and not 0.

Microsoft SQL: Added missing keywords for syntax coloring.

Microsoft SQL: Configuring Max Text column lengths now affects all character based fields.
Microsoft SQL: Fixed bug where search results for asimilar object type would get split across
multiple result folders.

Microsoft SQL: Expanded name on Columns tab within object view.

Microsoft SQL: Added configuration optionsto set initial connection settings.

Sybase SQL: Added configuration options to set initial connection settings.
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Version 1.3.5 (October 6, 2001)

1. Fixed errors around the use of GO. Changed behavior to be consistent with other apps: A GO
will break statements into batches only if the GO isthe only token on the line.

2. Fixed 'text contains searching for SQL Server 2000.

Version 1.3.4 (August 28, 2001)
1. Fixed parser error that |ead to erroneously displayed key columns at the end of the grid (in some

Cases).
2. Fixed bug where a protected grid can be edited if the previous grid was in edit mode.
3. Fixed bug on login screen for first time users.

Version 1.3.3 (July 6, 2001)

1. Fixed syntax coloring for single line comments

(New bug introduced with version 1.3.2).

Auto selection of server on connection dialog is no longer case-sensitive.
GUI changesto clarify how to connect using integrated security.
Integrated security connections now work against SQL Server 2000.

El S

ersion 1.3.2 (July 1, 2001)
"Close All" now closes all window types.
"Close All" will now prompt to save changed files.
Searching for objects containing double quotes now works as expected.
Fixed numerous bugs around Find/Replace when using "Whole Word'.
Fixed memory leak in Edit->Find/Replace.
Syntax coloring now works with multi-line quoted strings.
Canceled searches no longer say "Running” in search history.
Added "Help->DLL Versions' option
Activated "Clear All" in text based windows.
10. Empty execution buffers no longer generate CTLib errors.
11.  Added suppressible warning when SQLDMO is missing.
12.  Added notification when SQLDMO isincompatible with version of SQL Server that isbeing
connected to.
13. Blocked processes tree now works for SQL Server 2000.
14. Made indent widths consistent within blocked processes tree.
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Version 1.3.1 (December 5, 2000)

1. Fixed problem with imprecise display of floats. (i.e. 0.2 =0.1999999...)
2. Hidden columns are no longer copied when copying from Grid.

3. Fixed handling of identity columns.



4.
S.

Fixed handling of Numeric and Decimal columns.
Added View Rows option for tables in the object browser.

Version 1.3.0 (October 2, 2000)
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11.

12.
13.
14.

"Show Insert SQL" and "Show Delete SQL" can now be used against a set of rows.

"Delete Row" can now be used against a set of rows.

Added new menu optionsto insert "set” text (i.e. "set statisticsio on")

Added Scroll Tracking for al grids.

Added Scroll Wheel support for all grids.

Canceling agrid query no longer makesit ineligible for "Allow Updates'.

Undo/Redo "grouping” improved to be more like the Visual Studio IDE.

Added configuration to control if search dialog always opens using default criteria or previous
criteria. Also added option in search history dropdown called <Default Settings>.

Added additional keywords for syntax coloring.

Fixed bug for both MS and Sybase implementations where a cancelled query would not always
be cancelled on the server even though it was cancelled on the client.

Fixed bug with Sybase stored procedure text occasionally missing spaces when text is extracted
from server.

Fixed bug where grid printing did not share printer settings with rest of application.

Right mouse clicking within a selection on the grid will no longer deselect the selection.

Fixed several minor problems with ReplaceAll and Find dialogs.

Version 1.2.3 (September 6, 2000)

1.

Fixed yet another bug with the Object tree collapsing/expanding.

Version 1.2.2 (September 5, 2000)

1.

Fixed problem with Object tree collapsing too far when expanding/collapsing folder using the '+'
symbol within the tree.

Version 1.2.1 (September 4, 2000)
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Fixed bug when modifying rowsin grid mode and using 11.x client.

Fixed bug when typing on keyboard and entire column or row is selected.

Can now activate default action in object tree by pressing <ENTER>.

Added AutoComplete for the server name on the login dialog.

Added 'Show Insert SQL' and 'Show Delete SQL' menu options to generate and display the SQL
statement for a Grid row. Menus are enabled under the same conditions that the ‘Allow Update'
is enabled.

Added configuration to control whether opened files open into the current Query window or a
new window. The default isfor opened filesto open into a new window.

Version 1.2.0 (August 6, 2000)
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Native support for MS SQL Server in addition to Sybase SQL Server.

Added support to display text/image columns. Max length to display is configurable.

Object Tree continues to show selection even when it doesn't have focus.

Spacing between multiple result setsis now consistent from one execution to the next.
Re-wrote cancel logic to resolve problems related to the interaction between canceling queries,
closing windows, and closing the app.



Fixed parsing of GO so that it doesn't need to be | eft justified, instead just the first command on
theline. Also fixed aparsing distinction between go and goto.

Added ability to force case-insensitive searches (for servers configured to be case sensitive).
Login dialog now autoselects Login Id and Server Type from your history as you type.
File->Open is now always enabled and will open a new Query window if none are open.

Fixed MRU & File->Open problem opening into wrong frame.

Fixed bug with setting numeric columns to null within the grid.

Re-fixed problem with grid's edit box prematurely losing focus.

Renamed User Tables and System Tables for added clarity.

Object summary windows now show object nhame to the left so they can be found in the Window
menul.

Version 1.1.3 (June 22, 2000)

1
2.

Printing from the results pane (in split pane mode) will now work.
Right mouse clicking in the results pane when it does not have focus will now bring up the menu
for the results pane and not the query pane. (split pane mode).

Version 1.1.2 (June 16, 2000)

1
2.

Copying to the clipboard from the grid will now aways work.

Added configuration option to control whether or not to set focus to the results pane when
executing aquery in split pane mode. The default is NOT to switch to the results pane. This
default is a change in behavior from previous versions of SQL Specialist, but more consistent
with SQLQuery's behavior.

Version 1.1.1 (May 24, 2000)

1.

2.

Cdll editing would prematurely lose focus when using split panes. Thiswould cause cell editsto
be near impossible.

Grid messages generated from a user action (update, delete, etc) should still be displayed in a
MessageBox and not the Grid Messages tab. This behavior was unintended and was causing
SQL Specialist to abort.

Fixed arare problem where the splitter bar would start to creep upward.

Version 1.1.0 (May 13, 2000)
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Added split window mode for Query and Results. Tabbed versionisstill available as an option.
Grid messages now go to own tab.

Added ability to use || (OR) within text fields for object searches.

Print List option is now available in Object Tree.

New query window will no longer be opened if additional connection could not be obtai ned.
Linked the '? on the toolbar to 'Help' and not "About'.

Version 1.0.2 (March 15, 2000)

1.

Fixed (again) looping problems with ReplaceAll.



Version 1.0.1 (January 30, 2000)

agrwbdPE

Find/Find Again attributes are now shared across all open text views.

Replace will no longer enter an infinite loop when FROM and TO strings are too similar.
Replace dialog will now set defaults based on what is selected in text.

Triggers are now displayed on their own tab when viewing table objects.

The application name is now shown in the task bar when sitting at Login dialog.

Version 1.0.0 (December 23, 1999)
SQL Specialist brings forward all the great features from SQLQuery.
Notable enhancements since SQL Query 3.3.x:
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8.

9

10.
11.
12.
13.
14.
15.
16.
17.
18.

All previously reported bugs have been fixed.

Alt-Tabbing order works like Visual Studio IDE.

Syntax coloring in query tab.

Unlimited Undo/Redo (Ctrl-Z, CTRL-Y).

Bookmarks now availablein all text windows,

Object pane moved out of query window for better accessibility & space management.
Dockable/resizeable control bars allow for the object window and status window to be docked to
any side or remain floating. (side by side docking and stacked docking allowed)

Object Browse, Search 1, Search2, and Recent trees split to different tabs. This should help you
from losing your place in the tree when doing a search, or accessing the MRU.

Query and results split into separate tabs. Multiple grid results go to different tabs.

Status pane added to show blocked processes and current users.

Open Query filename is now clearly displayed in thetitle bar (with “*” if file changed).

Find within Grid is now allowed.

Connections to new servers now spawn anew copy of the application.

Font Name/Size displayed in configuration.

Object properties and text merged into single view.

Tab size can now be set.

Tab can be configured to insert a certain number of spaces instead of atab.

New configuration added to remove new line characters from text results.

Notable Bug Fixes since SQL Query 3.3.x:

1. If “Prompt to save changed files” configuration is turned on, program will now prompt even
when opening afile over another in the same query window.

2. Grid OCX now upgraded to newer version if necessary..

3. All other reported bugs from SQL Query have been fixed.

Intentionally removed since SQL Query 3.3.x:

1 C++ Style single line comments not needed. SQL standard defines “--* instead of “//”.
Registration
SQL Specidlist is shareware. If you continue to use SQL Specialist for more than 30 days, you are expected to
register.
Cost: US $10
Register At: https://usd.swreg.org/soft_shop/47908/index.shtml

Delivery:

Registration code will be sent viaemail.


https://usd.swreg.org/soft_shop/47908/index.shtml




Feedback

Wickedly Simpleisinterested in your feedback regarding SQL Specialist.
Our web site provides information about how to report problems or to suggest new features.
Please let us know what you think.
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